
Social,
Economic,
& Political

Factors

Risk
Management

DecisionRegulatory Action

Exposure-Event Module
(TRIM.Expo)

Risk Characterization
Module

(TRIM.Risk)

Environmental Fate,
Transport, & Ecological

Exposure Module
(TRIM.FaTE)

TRIM
Total Risk Integrated Methodology

TRIM.Risk User’s Guide
Volume I: Introduction to TRIM.Risk

U.S. Environmental Protection Agency
Office of Air Quality Planning and Standards

Research Triangle Park, NC 27711

December 2005





Table of Contents i December 2005

TABLE OF CONTENTS

List of Exhibits . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ii

1. Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
1.1 What Is TRIM.Risk? . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
1.2 Capabilities . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
1.3 How to Use this Document . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-7

2. TRIM.Risk Associated Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1
2.1 Java . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1
2.2 The Multimedia Integrated Modeling System (MIMS) . . . . . . . . . . . . . . . . . . . 2-1
2.3 MySQL . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
2.4 R . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
2.5 Other Associated Required Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2

3. Getting Familiar with the TRIM.Risk Computer Framework . . . . . . . . . . . . . . . . 3-1
3.1 Basic MIMS Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1

3.1.1 Starting MIMS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4
3.1.2 Importing a MIMS Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4
3.1.3 Exporting a MIMS Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-6
3.1.4 Opening a MIMS Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7
3.1.5 Creating a MIMS Project . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7
3.1.6 Opening, Duplicating, Renaming, or Deleting a MIMS Scenario . . . . . 3-8
3.1.7 Specifying MIMS Scenario Parameter Values . . . . . . . . . . . . . . . . . . . 3-9
3.1.8 Specifying MIMS Module Instance Parameter Values . . . . . . . . . . . . 3-11
3.1.9 Running a MIMS Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-13
3.1.10 Creating a New MIMS Scenario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-14
3.1.11 Navigating the MIMS Windows . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-15
3.1.12 Setting Parameters Using Environmental Variables . . . . . . . . . . . . . . 3-17

3.2 Basic MySQL Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-18
3.2.1 Viewing Data in a MySQL Database . . . . . . . . . . . . . . . . . . . . . . . . . 3-19
3.2.2 Editing a MySQL Database . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-19
3.2.3 Exporting Data from a MySQL Database . . . . . . . . . . . . . . . . . . . . . . 3-19

3.3 Basic Operations with DAVE . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-20
3.3.1 Data Export . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-21
3.3.2 Data Analysis . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-22

Appendix A.  Relationship between DAVE and the MIMS Analysis Engine . . . . . . . . . . A-1



List of Exhibits ii December 2005

LIST OF EXHIBITS

Exhibit 1-1.  TRIM Modeling System . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3
Exhibit 1-2.  User Guides and Related Documents for TRIM Modeling System . . . . . . . . . . . 1-5
Exhibit 3-1.  Overview of MIMS Building Blocks . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
Exhibit 3-2.  Domain Objects and Module Instances in the MIMS GUI . . . . . . . . . . . . . . . . . 3-3



Introduction 1-1 December 2005

1. Introduction

The TRIM.Risk User’s Guide is part of EPA’s series of documentation for the Total Risk
Integrated Methodology (TRIM) modeling system.  This document provides instructions and
reference information for using TRIM.Risk.  In general, the information presented in this
document is based on EPA’s experience with the test applications of TRIM.Risk that have been
implemented to date.  The information included in this document may be subject to change as
additional model applications are completed and the TRIM.Risk model evolves.

1.1 What Is TRIM.Risk?

TRIM.Risk is a collection of tools used for the characterization of human health and
ecological risk.  The capabilities of TRIM.Risk will include:

• Human inhalation risk and hazard assessment, using non-probabilistic response
values (e.g., UREs, RfCs);

• Human inhalation risk and hazard assessment, using probabilistic response
functions (e.g., distributions of exposure-response functions);

• Human ingestion risk assessment; and
• Ecological hazard assessment, using non-probabilistic response values.

Exhibit 1-1 provides the conceptual design for the TRIM modeling system.

1.2 Capabilities

The two different types of analyses that can be performed with the initial public release
of TRIM.Risk are summarized below.

• Human Inhalation Risk Assessments Using Non-probabilistic Response
Values.  For this type of analysis, TRIM.RiskHH-NP utilizes exposure data from an
inhalation exposure model (e.g., TRIM.ExpoInhalation or HAPEM) and non-
probabilistic toxicity values (e.g., UREs and RfCs) from the human health
toxicity database.  The initial capabilities are for chronic assessments.  For these
assessments, annualized hazard or cancer risk values are generated for each of the
individuals modeled in the exposure model and these annualized values are then
used as “building blocks” to generate user-specified chronic risk metrics.  These
include both individual and population risk metrics for chronic hazard and cancer
risk.  Detail on this type of analysis is provided in Volume II.



1  TRIM.RiskEco is also compatible with ecological exposure estimates generated by other ecological
exposure models, provided the exposure estimates are supplied in the TRIM.FaTE MySQL database format.  See
Volume III for more details.
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• Ecological Risk Assessments.  For these types of analyses, TRIM.RiskEco
combines ecological exposure estimates (e.g., generated by TRIM.FaTE1) with
toxicity values from the ecological toxicity database to calculate ecological
hazard quotients for user-specified exposure metrics and ecological receptors.

The outputs from each of these types of analyses can be processed into tables and plots using the
Data Analysis and Visualization Engine (DAVE), which is described in a separate document.
Future releases will include capabilities for human inhalation risk assessment using probabilistic
response functions and human ingestion risk assessment.

Several key terms that are used throughout this User’s Guide are defined in the text box
on the following page.  In addition, users are encouraged to review the user guides and technical
support documentation for the other parts of the TRIM modeling system (listed in Exhibit 1-2) to
gain a better understanding of the overall modeling system.  These documents are available for
download from EPA’s Fate, Exposure, and Risk Analysis (FERA) website
(http://www.epa.gov/ttn/fera).
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Exhibit 1-1.  TRIM Modeling System
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KEY TERMINOLOGY FOR TRIM.RISK ANALYSES

Biota Intake: The estimated rate of intake (via ingestion) of a chemical by a biotic compartment.  This is an
optional output of TRIM.FaTE, currently for birds and mammals.

Body Burden: The whole body concentration of a chemical in a biotic compartment.  This is an output of
TRIM.FaTE simulations that involve biotic compartments.

Compartment:  The TRIM.FaTE modeling unit that contains chemical mass.  Chemical mass is transported
between and transformed within compartments; a specific compartment is characterized by its physical and
spatial composition and its relationship to other compartments.

Component: One of the individual models or programs (e.g., APEX, TRIM.Risk Metrics Generator,
TRIM.FaTE) used to perform one or more model simulations of an application.

JAR File: An executable file created using the Java programming language (i.e., Java ARchive).  This file
format enables you to bundle multiple files into a single archive file. Typically a JAR file will contain the class
files and auxiliary resources associated with applets and applications.  Users do not need to modify this, but
only ensure that the model is able to locate where it is stored.

MIMS Custom GUI: A specialized GUI interface used to configure inputs for some MIMS modules.  Specific
examples of these are referred to as TRIM.RiskEco GUI and TRIM.RiskHH Inhalation Metrics GUI .

MIMS Domain Object: A “wrapper” containing one or more MIMS module instances that manages the inputs
to and outputs from these module instances.  It serves to insulate the module instances from other parts of a
MIMS scenario so that module instances can be replaced (e.g., updated with a new version of a model) without
impacting the input and output connections to other parts of the MIMS scenario.

MIMS Module and Module Instance: The “encapsulation” of a model or program in MIMS.  A module
defines the link between MIMS and the models and programs (i.e., components) used in applications.  It is a 
GUI interface within a MIMS scenario and allows the user to specify settings (e.g., location of input data) for
executing the model or program.  When these settings are specified, a module instance is created combining the
module with these specified settings.  In most cases, users will only need to interact with module instances.

MIMS Project: The building block of a MIMS application.  Simply, it is a computer framework used to save
the configuration of an application (i.e., a MIMS scenario) as well as the links to external models and programs
that are used in the application.

MIMS Parameter:  Information that is defined about a MIMS scenario or specific TRIM.Risk module (e.g.,
Output Directory, Control File).  A parameter may be the location of files and directories, true/false statements,
or specific data needed for a scenario to be run.

MIMS Scenario: The element of MIMS that defines the programs (i.e., MIMS modules) – as well as the
operational sequence of these programs – used to perform one or more model simulations of an application.

Simulation:  A single application of a module or set of modules to estimate human health risks or ecological
hazards.

TRIM.FaTE Library: A TRIM.FaTE file that contains the objects available for building a TRIM.FaTE
simulation: algorithms, chemicals, compartments, sources, and property types.

TRIM.FaTE Project:  A computer framework for saving one or more TRIM.FaTE scenarios, including all of
the data properties for those scenarios.



Introduction 1-5 December 2005

Exhibit 1-2.  User Guides and Related Documents for TRIM Modeling Systema

Document Title Year Description

USER’S GUIDES

TRIM.FaTE User’s Guide 2003 User’s guide for the TRIM.FaTE module; includes instructions for
creating the inputs required by the TRIM.Risk ecological risk assessment
application.

TRIM.ExpoInhalation (APEX) User Guide 2003 User’s guide for running the TRIM.ExpoInhalation module using APEX.

Decision Points for Configuring APEX for Air
Toxics Exposure Assessments

2005 Describes the decisions involved in configuring APEX for air toxics
applications and provides some helpful information for making these
decisions.

TRIM.ExpoInhalation (APEX) Programmer’s Guide future Describes the model and computer code in more detail than the User’s
Guide.  Provides advanced users with a greater understanding of the
model and guidance for implementing advanced options and capabilities.

TRIM.ExpoIngestion User Guide future User’s guide for running the TRIM.ExpoIngestion module.

TRIM.Risk User’s Guide

Volume I: Introduction to TRIM.Risk 2005 Overview of TRIM.Risk and associated required software.

Volume II: Human Health Inhalation Risk
Assessment with Non-Probabilistic Exposure-
Response Values

2005 User’s guide for performing inhalation risk assessments with non-
probabilistic response values (e.g., UREs, RfCs) using TRIM.Risk

Volume III: Ecological Risk Assessment 2005 User’s guide for performing ecological risk assessments using
TRIM.Risk

Volume IV: Human Inhalation Risk Assessment
with Probabilistic Response Functions

future User’s guide for performing inhalation risk assessments with
probabilistic response functions using TRIM.Risk

Volume V: Ingestion Risk Assessment future User’s guide for performing ingestion risk assessments using TRIM.Risk

Data Analysis and Visualization Engine User’s
Guide

2005 User guidance for using the Data Analysis and Visualization Engine



Document Title Year Description

Introduction 1-6 December 2005

RELATED DOCUMENTS

TRIM.FaTE Technical Support Document

Volume I: Description of Module 2002 Provides a description of terminology, model framework, and
functionality of TRIM.FaTE.

Volume II: Description of Chemical Transport
and Transformation Algorithms

2002 Presents a detailed description of the algorithms used in TRIM.FaTE.

Evaluation of TRIM.FaTE

Volume I: Approach and Initial Findings 2002 Describes a set of evaluation analyses performed on TRIM.FaTE
primarily during 2000, with some spanning into 2002.

Volume II: Mercury Test Case 2005 Describes a detailed performance evaluation of TRIM.FaTE based on
mercury emitted to the air from an industrial source and includes an
overall assessment of mercury fate using TRIM.FaTE, a sensitivity
analysis, a steady state analysis, a comparison to monitoring data, and a
comparison to other modeling results from an assessment by EPA’s
Office of Research and Development.

Volume III: Model Comparison Focusing on
Dioxin Test Case

2005 Describes the comparison of results from the application of
TRIM.FaTE to emissions of dioxin-like compounds from a municipal
solid waste combustion facility to dioxin monitoring data and modeling
results presented in an earlier assessment conducted by EPA’s Office of
Research and Development.

Volume IV: Model Evaluation Focusing on
Dioxin Test Case

2005 Evaluates the sensitivity of TRIM.FaTE to changes in emission rates and
spatial resolution and to the inclusion of biotic compartments for an
application to emissions of dioxin-like compounds from a municipal
solid waste combustion facility.

a All of the documents presented in this exhibit are or will be available from http://www.epa.gov/ttn/fera.



2  TRIM uses the Multimedia Integrated Modeling System (MIMS) to provide the computer framework to
run multiple models in sequence while sharing input and output files as well as a common set of tools and utilities.

Introduction 1-7 December 2005

1.3 How to Use this Document

The TRIM.Risk User’s Guide has been designed to meet the needs of various types of
users, depending on their level of experience with the TRIM modeling system.  This section
describes briefly how new and experienced users would benefit most from their use of this
document.

New Users.  Users who are new to TRIM.Risk should first review the Introduction (this
chapter) and Chapter 2 to gain an overall understanding of the TRIM modeling system. 
If they are unfamiliar with other parts of the TRIM modeling system, they should also
refer to the TRIM documents listed in Exhibit 1-2 for additional information about the
TRIM modules that interact with TRIM.Risk (e.g., TRIM.ExpoInhalation, TRIM.FaTE).

After becoming familiar with the overall design of TRIM.Risk and its place in the TRIM
modeling system, new users should read Chapter 3 (i.e., “Getting Familiar with the
TRIM.Risk Computer Framework”).  After becoming familiar with the TRIM.Risk
computer framework, users should consult the initial sections of Volumes II and III of
this User’s Guide that describe different types of TRIM.Risk applications to familiarize
themselves with navigating the TRIM.Risk framework2 for different purposes.  Next,
they should proceed to the detailed instructions on using TRIM.Risk to perform human
inhalation risk assessment with non-probabilistic response values and ecological risk
assessments provided in Volumes II and III, respectively.  These volumes provide: (1)
descriptions of a number of options for performing these types of analyses, (2) step-by-
step instructions for each option, and (3) detailed descriptions of the components used in
each option.

Experienced Users.  After becoming familiar with using TRIM.Risk, experienced users
can continue to use Volumes II and III as references for details about the different
TRIM.Risk components and MIMS scenarios.  This User’s Guide is designed so that
experienced users can quickly find step-by-step instructions or detailed descriptions of
relevant components for a particular application of TRIM.Risk without needing to refer
back to the introductory material in Volume I.  In addition, experienced users may find
that their needs could be more easily met if they created a new MIMS scenario.  These
users should refer to Section 3.1.10 for information about creating new MIMS scenarios.



[This page intentionally left blank.]
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2. TRIM.Risk Associated Software

TRIM.Risk is a collection of tools for risk characterization.  The TRIM.Risk computer
programs are largely written in Java, the TRIM.Risk input and output databases are in MySQL
format, and all are “housed” in the MIMS computer framework, which is compatible with
Microsoft Windows operating systems.  This section provides an overview of the different types
of software that the user will need to install along with TRIM.Risk.

In order to use TRIM.Risk, the user must install the Java Runtime Environment (JRE),
EPA’s Multimedia Integrated Modeling System (MIMS), and MySQL.  The JRE is required to
run any software written in the Java programming language and is thus required to run
TRIM.Risk.  MIMS provides a user interface for TRIM.Risk as well as the computer framework
within which the different parts of the TRIM.Risk system communicate with each other. 
MySQL is a relational database management system used to manage data within the TRIM
modeling system.  Users who wish to generate graphs or plots of TRIM data using DAVE must
also install R, a software suite for data manipulation, calculation, and graphical display.

Sections 2.1, 2.2, 2.3, and 2.4 of this chapter describe the roles of Java, MIMS, MySQL,
and R, respectively, in the TRIM.Risk system.  Section 2.5 briefly mentions the software
required for different types of TRIM.Risk applications.

2.1 Java

The majority of the TRIM.Risk computer programs, as well as some of the associated
programs (e.g., TRIM.FaTE), are written in the Java programming language.  All programs
written in Java require that users have the JRE installed.  The JRE contains the core executables
and files that constitute the standard Java platform, including the Java Virtual Machine (JVM),
core classes, and supporting files.  For more information on Java and the JRE, users should refer
to http://java.sun.com.

TRIM.Risk users are required to have the Java Runtime Environment (JRE) installed on
their computer.  Information on installing the JRE for TRIM is provided on the TRIM
installation page, accessible via the EPA FERA website (http://www.epa.gov/ttn/fera).

2.2 The Multimedia Integrated Modeling System (MIMS)

MIMS is a modeling framework developed by EPA that is designed to allow users to
configure multiple related models and programs and specify the settings (e.g., input file
locations, model options) for these models and programs within a single interface.  MIMS also
manages the inputs and outputs for each model and program, allowing the outputs created by one
model or program to be automatically used as inputs to another model or program within a single
simulation.  In addition, MIMS provides a standardized set of tools that can be used to process
the outputs (e.g., create plots or tables) generated by different simulations.  MIMS must be
installed to run any of the TRIM.Risk applications described in this document and is made
available to TRIM users via the TRIM installation software available on the TRIM installation



3  Users are not required to install an exposure model for a particular type of application if they plan to use
(1) exposure estimates previously generated using one of the exposure models compatible with TRIM.Risk or (2) an
existing exposure MySQL database in the proper format. 
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page, accessible via the EPA FERA website (http://www.epa.gov/ttn/fera).  Section 3.1 provides
an overview of the MIMS operations required to run TRIM.Risk.

2.3 MySQL

Because many of the TRIM modules rely on input data created by external programs and
other TRIM modules, a consistent methodology was developed to manage data within the TRIM
modeling system.  The basis of this data management methodology is MySQL, a relational
database management system that is available for free via the Internet.  Additional information
about MySQL can be found on the MySQL website (http://www.mysql.com).  Within the
framework of TRIM, MySQL software provides a standardized language for the links between
various TRIM data tables.  This facilitates the operation of TRIM.Risk by providing a
standardized mechanism for reading input data (e.g., exposure-response values) and writing
outputs (e.g., cancer risk estimates).

Users are not required to have a detailed understanding of MySQL because the creation
and accessing of MySQL databases is handled internally by the different parts of the TRIM
modeling system.  Because users can use DAVE to create tables, plots, or text exports of the
TRIM outputs in MySQL format, it is not necessary for TRIM.Risk users to ever interact directly
with a MySQL database.  However, users familiar with writing SQL queries can use MySQL to
access the data in these databases.  Additionally, Section 3.2 provides an overview of some basic
MySQL operations that can be used to access databases created using TRIM.Risk.  Information
on installing MySQL for TRIM is provided on the TRIM installation page, accessible via the
EPA FERA website (http://www.epa.gov/ttn/fera).

2.4 R

Users who wish to generate plots or graphs using DAVE must also install R, a software
suite for data manipulation, calculation, and graphical display available for free via the Internet. 
R is used by DAVE to generate graphs and plots of data contained within TRIM databases (e.g.,
risk metrics, exposure estimates).  Additional information about R can be found on the R website
(http://www.r-project.org/).  As with MySQL, users are not required to have a detailed
understanding of R because it is implemented through the DAVE graphical user interface (GUI)
and users are not required to interact directly with R.  For additional details on how R is used by
DAVE, refer to the DAVE User’s Guide.  Information on installing R for TRIM is provided on
the TRIM installation page, accessible via the EPA FERA website (http://www.epa.gov/ttn/fera).

2.5 Other Associated Required Software

In addition to installing Java, MIMS, and MySQL, TRIM.Risk users must also install the
appropriate TRIM.Risk software package(s) for their applications of interest, as well as any
exposure models and databases needed to generate exposure estimates for these applications.3 
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The TRIM.Risk software is provided on the EPA website (http://www.epa.gov/ttn/fera) along
with a TRIM installation program that assists users in downloading the software corresponding
to their TRIM.Risk application needs.  Additional discussion of this software is provided with
the subsequent volumes of this User’s Guide, which focus on the use of TRIM.Risk for specific
types of assessments.



[This page intentionally left blank.]
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3. Getting Familiar with the TRIM.Risk Computer Framework

This chapter provides instructions on basic MIMS, MySQL, and Data Analysis and
Visualization Engine (DAVE) operations.  The basic MIMS operations are the same in all of the
TRIM.Risk projects, and users must be familiar with them in order to navigate the MIMS
system.  The basic operations in MySQL and DAVE will help users be able to view and analyze
the results of any TRIM.Risk application.  This chapter is intended as a guide to help users
develop a better understanding of the TRIM.Risk computer framework and does not provide
detailed instructions for performing any specific assessment.  For further instructions on tasks for
specific assessments, users are encouraged to consult the subsequent volumes of this User’s
Guide.  

Information pertinent to the use of MIMS, such as start-up, importing and exporting
projects, opening projects and scenarios, specifying parameter values in scenarios and module
instances, and running a scenario is included in Section 3.1.  An overview of the MIMS scenario
and module instance windows and components is also provided.  Section 3.2 contains
information on the basic operations of MySQL.  Analysis and export of TRIM databases, the
principal functions of DAVE, are described in Section 3.3.  

3.1 Basic MIMS Operations

TRIM.Risk is designed to run in MIMS.  Exhibit 3-1 illustrates the main MIMS concepts. 
This figure presents several of the key MIMS terms, how they relate to each other, and provides
examples of these terms from a MIMS application.  The remainder of this section provides a
brief description of the meaning of these terms.

A MIMS Project serves as a container for the building blocks of a MIMS application.  It
is used to save the configuration of an application and the links to external models and programs
that are used in the application.  Each MIMS project contains one or more MIMS Scenarios,
which are the elements of MIMS that define the operational sequence of the models and
programs used to perform a particular type of application.  The links between MIMS and these
models and programs are defined by MIMS modules.  A MIMS Module is the “encapsulation”
of a model, software program, or code fragment (i.e., components) within the MIMS framework.
A module defines the link between MIMS and the components used in applications.  It provides
a  GUI interface within a MIMS scenario to allow the user to specify settings (e.g., location of
input data) for executing the component.  When these settings are specified, a MIMS Module
Instance is created combining the module with these specified settings.  Unlike modules,
module instances are part of scenarios and therefore, in most cases, users will only need to
interact with module instances.
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Exhibit 3-1.  Overview of MIMS Building Blocks

There are two types of modules used in TRIM.Risk.  Custom GUI External Modules
(i.e., custom GUIs) have been developed to configure the inputs and settings for the
TRIM.RiskEco and TRIM.Risk metrics generator programs.  These GUIs are separate user
interfaces that are opened from within a MIMS scenario and allow the user to configure the
inputs and settings for the MIMS modules instances with more complicated input requirements. 
Default External Modules are modules that represent programs that are external to MIMS, but
can be run through MIMS (e.g., TRIM.FaTE, APEX).  Information about a MIMS scenario or
module is specified using MIMS Parameters.  For users familiar with TRIM.FaTE, a MIMS
parameter is similar to a TRIM.FaTE property.  A parameter may be the location of files and
directories, true/false statements, or specific data needed for a scenario to be run.  The List
Iterator enables a module to be iterated over the items from one or more Lists of Parameters
(e.g., chemicals, names of control strategies, or facilities).
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The Domain Object is a “wrapper” containing one or more MIMS module instances that
manages the inputs to and outputs from these module instances.  It serves to insulate the module
instances from other parts of a MIMS scenario so that module instances can be replaced (e.g.,
updated with a new version of a model) without impacting the input and output connections to
other parts of the MIMS scenario.  Exhibit 3-2 illustrates where domain objects and module
instances appear in the MIMS interface.  The Framework Object is an operational component
within the MIMS scenario.  The tasks of framework objects are typically independent of the
environmental models and instead represent computational functions, such as advancing time
steps or clearing temporary files from the hard disk.  Framework objects also contain parameters. 
Note that framework objects do not require any user interaction; they are simply tools that are
used in performing different tasks in MIMS.

Exhibit 3-2.  Domain Objects and Module Instances in the MIMS GUI

Users will find TRIM.Risk easier to navigate if they become familiar with the basic
MIMS operations described below before attempting to configure and run a TRIM.Risk
simulation.  Additional information about MIMS terminology, concepts, and functionality can be
found at http://www.cmascenter.org/tutorials/MIMS.

Domain
Objects

Module
Instances
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3.1.1 Starting MIMS

After completing the installation, users can start MIMS by navigating to the Start menu,
Programs, TRIM, and selecting “TRIM” or by double-clicking on “runtrim.bat” in Windows
Explorer.  When MIMS is started, the “TRIM - Project Selection Window” will appear.  If this is
the first time that TRIM.Risk has been run through MIMS on this computer, the “TRIM - Project
Selection Window” will be blank as shown below.  If projects had previously been imported,
their names would show up in this window under “Double click on one of the following
options.”

3.1.2 Importing a MIMS Project

Depending on the type of analysis required, there are several pre-packaged MIMS
projects available with the TRIM.Risk installation package.  These projects are distributed in
MIMS project files, typically in binary format (i.e., *.bin files).   An example is the project
“Ecological risk assessment with TRIM.FaTE.”  When users wish to install one of the MIMS
projects, they must download the .bin project file to their computers and complete the following
steps. 
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Step 1. Open MIMS (as described in Section 3.1.1)

Step 2. From the “TRIM - Project Selection Window,” select “Import Project”
from the “File” menu.

Step 3. After selecting “Import Project,” a file browser will appear.  Use this
browser to locate the MIMS project file and select it.  After selecting the
project file, click “Import.”

Step 4. In the “Import Project” window, enter a name for this version of the
MIMS project and click “OK.”  The user may run several versions of the
same project and wish to distinguish them with different names.
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After specifying a name, the imported MIMS project will appear in the list
of available projects in the “TRIM - Project Selection Window.”

3.1.3 Exporting a MIMS Project

In some cases, a user may need to move a MIMS project between computers or send a
project to another user.  To do this, the user must export the MIMS project into a file format that
can be transported between computers.  To export a MIMS project, users must complete the
following steps.

Step 1. Open MIMS (as described in Section 3.1.1)

Step 2. From the “TRIM - Project Selection Window,” select the project to be
exported.

Step 3. Select “Export Project” from the “File” menu of the “TRIM - Project
Selection Window.”  Follow the arrow next to the “Export Project” option
to select the desired format of the export (“to XML” or “to BIN”).  Note
that in most cases, the BIN (or binary) format is the recommended export
format for a TRIM.Risk user.  The XML file type results in larger file size,
and should only be used if the user needs it for a particular application.

Step 4. After selecting an export format, a file browser will appear.  Use this
browser to specify a name and location for the export file.  After
specifying a name and location, click “Open” and the project will export.
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3.1.4 Opening a MIMS Project

Users can open a previously imported MIMS project by double-clicking on the project in
the “TRIM - Project Selection Window” or by clicking on the project in the “TRIM - Project
Selection Window” and selecting “Open Project” from the “File” menu.

3.1.5 Creating a MIMS Project

Users can create new MIMS projects to meet the needs of specific assessments.  The pre-
packaged projects available with the TRIM.Risk installation are very comprehensive and should
meet the needs of most users.  However, if users wish to create new MIMS projects, they will
need to consult with the MIMS documentation for more information.  Users should refer to the
“MIMS for Models-3 Applications Tutorial” (available at
http://www.cmascenter.org/tutorials/MIMS) for additional information about MIMS concepts
and what is required for a MIMS project.  The general steps to follow are listed here.

Step 1. From the “TRIM - Project Selection Window,” under the “File” menu,
select “New Project.” 
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Step 2. Enter a unique name for the new project.

Step 3. Design the new project by adding scenarios, modules, and domain objects. 
See the MIMS documentation for more information on these steps.

3.1.6 Opening, Duplicating, Renaming, or Deleting a MIMS Scenario

After a MIMS project has been opened (as described in Section 3.1.4), a window will
appear displaying the list of scenarios contained within the project.  Users can open, duplicate,
rename, or delete scenarios from this window.  Users can open, duplicate, rename, or delete one
of the scenarios listed in this window by selecting the scenario and clicking the appropriate
button below the list of scenarios.
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The duplicate feature may be useful for users who wish to perform and save multiple,
similar applications (e.g., model two different emission scenarios with all other inputs identical). 
Users should be careful when renaming scenarios included with the pre-packaged TRIM.Risk
projects because the instructions in Volumes II and III refer to the scenario names in the pre-
packaged projects.  However, these included scenarios can always be recreated if they are
unintentionally changed or deleted by re-importing the MIMS project.

Note that this window also lists other building blocks of the MIMS project.  From the
drop-down menu labeled “Category,” in addition to the scenarios, users can also view the other
building blocks of the project (e.g., external modules, domain objects).  These parts of a MIMS
project are all defined in Section 3.1 above, and should not be modified by users unless they are
creating a new project.

3.1.7 Specifying MIMS Scenario Parameter Values

For each MIMS scenario, the scenario parameter set includes parameters that specify the
location of model components, executables, and log files as well as parameters that are used for
other MIMS processes (note that not all scenario parameters are needed in every application). 
For each of the pre-packaged scenarios available with TRIM.Risk, the scenario parameters that
are frequently changed by users (e.g., file locations, database names) are listed on tabs in the
“Input Panels” pane of the scenario window, which is on the left side of the scenario window
shown below.  The user can edit the parameters in the “Input Panels” by typing in new values or
using the “Browse” button to select files.  Any changes made to parameters in this panel will be
saved in the parameters table (described below).
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The full set of parameters can be accessed one of two ways.  The user can select “Edit
Parameter Values” from the “Scenario” drop-down menu, and the parameter table will open in a
pop up window.  Alternatively, the user can check the box next to “Parameter Table” in the
“View” drop-down menu and the parameter table will appear as a new pane at the bottom of the
scenario window.  The parameter table that opens will have a short list of parameters.  To access
the remaining parameters, called “File Management Parameters,” either click on the “Edit”
button in the “File Management Parameters” row, or click on the expand button ( ).  The
parameters table lists the following attributes for each parameter:

Attribute Description

Object Type The type of domain object connected with the parameter

Parameter The name of the parameter

Value The parameter’s value or file name where information is stored.  GUI controls
for setting the value may be in the adjacent un-labeled column

Source If the parameter is read from a domain or framework object, this field indicates
the object name

Status Indicates whether the parameter is an input, output or both an input and output
to the module, and whether the parameter is required to run the module

The user should input values for all required parameters.  See Volumes II and III for lists
of required scenario parameters for each project.  If a value is required but not entered, the text in
the “Status” column will be red.  There are four different ways to enter values for a parameter:
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• If the cell next to the value cell has a “Browse” button, click the button and
browse the file directory for the correct file or location;

• If the cell is blank, type the value of the parameter into the “Value” column;

• If the cell contains a check box, check the box to indicate “Yes,” or un-check the
box to indicate “No”; or

• If the cell contains a button, click on it to turn it into a drop-down menu with the
options for the parameter value.

When the scenario parameter table is closed, the values will be automatically saved.  If a
required scenario parameter value is not set before the simulation is executed, an error will be
generated when the user attempts to start the simulation.

3.1.8 Specifying MIMS Module Instance Parameter Values

Module instance parameters are parameters that contain information required to run a
module through MIMS.  For each of the pre-packaged scenarios available with TRIM.Risk, the
module instance parameters that are frequently changed by users (e.g., file locations, database
names) are listed on one of the tabs in the “Input Panels” pane of the scenario window along
with commonly used scenario parameters described in 3.1.7.  In addition, all of the module
instance parameters can be accessed by double-clicking on the module instance name (i.e., the
bottom half of the box that contains the domain object and module instance names, as identified
in the screen shot below).
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The module instance window has two tabs.  The “Module” tab contains information
about the module and does not need to be edited.  The “Parameters” tab contains the module
instance parameters.  These parameters are specific to the module instance and can be edited by
entering new values into the “Value” column of the parameters table.  Some parameters may be
hidden from view.  To view all parameters, click the expand button, .  The “Parameters” tab
contains the following attributes for each parameter:

Attribute Description

Object Type The type of domain object connected with the parameter

Parameter The name of the parameter

Value The parameter’s value or file name where information is stored.

Additional Type Info Additional information or GUI controls needed for the parameter
(units, file locations, time zones, field delimiters, labels, etc.)

Source If the parameter is read from a domain or framework object, this field
indicates the object name

Status Indicates whether the parameter is an input, output or both an input
and output to the module, and whether the parameter is required to
run the module

Domain
Objects

Module
Instances
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The user should input values for all required parameters.  If a value is required but not
entered, the text in the status column will be red.  There are three different ways to enter values
for a parameter:

• If the cell next to the value cell has a “Browse” button, click the button and
browse the file directory for the correct file or location;

• If the cell is blank, type the value of the parameter into the “Value” column; or

• If the cell contains a check box, check the box to indicate “Yes,” or un-check the
box to indicate “No.”

After setting all of the necessary parameters in the module instance, close the window by
clicking on the “X” in the upper right-hand corner (the updated values are saved automatically). 
A green circle, , should appear next to the process name after the necessary module instance
parameters are set.

3.1.9 Running a MIMS Scenario

To run a MIMS scenario, users must first specify all of the required settings and inputs.
Volumes II and III contain detailed descriptions of the steps involved in configuring each of the
scenarios included in the initial release of TRIM.Risk.  After specifying all of the required
information, green circles (i.e., ) will appear next to all of the processes in the “Graph View”
of scenario pane of the scenario window.  These circles indicate that the required inputs for
running each module have been specified.
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Users can run the scenario by selecting “Execute All” from the “Scenario” menu of the
scenario window or by clicking on the “Play” button on the top of the scenario window (i.e., ). 

While the simulation is running, the green circles will be shaded (i.e.,  ).  If the run does not
complete successfully, the solid green circles will be replaced by a .  When a simulation does
not complete successfully, users should review the specified settings and inputs to confirm that
they are valid (see Volume II and III for detailed descriptions of valid inputs and settings for
each included scenario).

When the simulation has completed successfully, the solid green circles in the “Graph
View” of scenario pane will be replaced with check marks (i.e., ).  This indicates that the
scenario has run successfully and written the outputs to the specified output database.

3.1.10 Creating a New MIMS Scenario

In some cases, users may find that their needs could be more easily met if they created a
new MIMS scenario.  This process requires an understanding of MIMS beyond the information
provided in this document; therefore users should refer to Chapters 1 and 2 of the “MIMS for
Models-3 Applications Tutorial” (available at http://www.cmascenter.org/tutorials/MIMS) for
additional information about MIMS concepts and how to navigate a MIMS project.

With a thorough understanding of MIMS, users can design and create a new MIMS
scenario.  In designing a new scenario, users should first determine the TRIM.Risk components
required to meet their needs.  Users should refer to Exhibit 1-1 in Section 1.2, the data flow
diagrams presented in Appendices of Volumes II and III, and the description of the different
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TRIM.Risk components in Volume II, Section 5 (for inhalation risk assessments), and Volume
III, Section 4 (for ecological risk assessments) to aid in understanding what each part of the
TRIM.Risk modeling system does and how all of the different pieces fit together.  After
determining the required components, users should determine if domain objects and modules for
these components have already been created in MIMS and, if so, the order that the modules must
be run and the external databases required by each module.  If one or more of the required
modules has not yet been created in MIMS, users must refer to Chapter 1 and the tutorials in the
“MIMS for Models-3 Applications Tutorial” for an explanation of how to create a MIMS
module.  After completing these steps, the basic design of the scenario is complete.

The next step is to create the new MIMS scenario based on this design.  Users should
refer to Chapter 1 of the “MIMS for Models-3 Applications Tutorial” for an explanation of how
to create a MIMS scenario.

3.1.11 Navigating the MIMS Windows

Scenario window

The MIMS scenario window is a way to view the MIMS building blocks (e.g., domain
objects, module instances, parameters) and to run the scenarios.  Section 3.1.6 explains how to
open a MIMS scenario.  There are different options for viewing items in the scenario window. 
The default view for the pre-packaged TRIM.Risk projects and scenarios is shown below.  Along
the top frame of the window are three icons that can be clicked to perform certain functions.  The
first is a reset button to reset the modules if they have been run previously (note that this button
does not undo the settings the user has specified); next is a play button which will start the
simulation; and last is a stop button which can be clicked to interrupt a simulation.  The lock in
the upper right corner indicates whether the structure of the scenario can be modified (if it is
unlocked) or cannot be modified (if it is locked).  Most of the time, TRIM.Risk users will not
have to modify the scenario structure (e.g., update modules) and thus the scenario is locked by
default.

Two panes are visible in this default view.  The pane on the left is the “Input Panels” and
can be used to input or modify some of the common scenario or module instance parameters (as
described in Sections 3.1.7 and 3.1.8).  Depending on the scenario, there may be one or many
tabs in this pane.  The pane on the right is the graph view of the scenario.  The domain objects,
module instances, and the run order can be viewed in the “Graph View.”  Two additional views
are available and can be added by checking the “Parameter Table” and/or “Tree View” options
under the “View” menu.  The parameter table is described in Section 3.1.7 and contains a list of
all of the scenario parameters (including those listed in the “Input Panels”).  The tree view is an
alternative view of the scenario, but the relationships between the components of the scenario are
not displayed in this view.
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Default Scenario window appearance

Scenario window with all available “panes”
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Module instance window

The MIMS module instance window is used to specify parameters required for running a
component in MIMS.  To open the module instance window, double-click on the module name
in the “Graph View” of scenario pane.  The window that opens contains two tabs: a “Parameters”
tab and a “Module” tab.  The parameter values required to run the component within MIMS are
specified on the “Parameters” tab.  See Section 3.1.8 for a description of how to set module
instance parameters.  There are no user inputs or interaction required in the module view, which
is accessed by clicking on the “Module” tab.

3.1.12 Setting Parameters Using Environmental Variables

When specifying file locations in MIMS, users may find it convenient to use
“environmental variables,” which allow users to make use of values of other parameters.  The
format used for environmental variables is:

${str(“Parameter Name”)}

where Parameter Name is a MIMS parameter name.  Environmental variables are most
commonly used to define a directory as a subdirectory of a previously defined directory or to
define a file location within a previously defined directory.  In this case, the user would use an
environmental variable in the file path to reference the previous directory and then add the name
of the subdirectory afterwards.  For example, the user may wish to define the “TRIM Data
Directory” parameter as a subdirectory of the “TRIM Directory,” which has already been defined
as “C:\Models\TRIM.”  Using environmental variables, the value of “TRIM Data Directory”
could be defined as:

${str(“TRIM Directory”)}\data
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which would be equivalent to entering the following value for the parameter:

C:\Models\TRIM\data

To define a parameter with a reference to a file named “airdata.txt” in the “TRIM Data
Directory” the user would enter:

${str(“TRIM Data Directory”)}\airdata.txt

which would be equivalent to entering the following value for the parameter:

C:\Models\TRIM\data\airdata.txt

Environmental variables are useful because they can limit the amount of text the user
must enter to define a directory or file location and because they allow users to make changes to
the locations of multiple directories and files with a change to a single parameter value instead of
forcing the user to change each directory or file location individually.  For more information on
setting environmental variables in MIMS, refer to the MIMS User Guide.

3.2 Basic MySQL Operations

In most cases, TRIM.Risk users should not have to interact directly with the data
contained in the MySQL databases that are either input or output from TRIM.Risk.  However, in
some instances, users may need to access the data directly in the database for certain functions
such as:

• Performing error-checking (e.g., to check that records are being sent to the
database);

• Changing a value in the database (e.g., if a toxicity value needs to be updated); or 
• Exporting results directly from the database for use in another application (e.g., a

spreadsheet application, such as Excel®).

The MySQL Query Browser, which is included with MySQL, is a useful tool for performing
these tasks.  The MySQL Query Browser can be found in the MySQL installation folder. 
Detailed instructions are included with the Query Browser installation.  A few operations that a
TRIM.Risk user may wish to perform are explained below.  Users familiar with MySQL queries
can also access the data contained within MySQL databases using MySQL queries.

Note that in order to navigate through the databases, some basic understanding of how
they are structured is required.  The schema for each of the databases included in the TRIM.Risk
installation package are included in the Appendices of Volumes II and III.  In general, each
database consists of a number of tables (e.g., benchmarks, results, chemicals).  Within each table
are fields that contain either input or output data.  These data fields are linked across tables to
create relational databases.



4  Changing the MySQL username or password from the default settings may cause problems with running
TRIM.Risk.  It is recommended that they are not changed unless by a user with significant experience with MySQL
and MIMS.

Getting Familiar 3-19 December 2005

3.2.1 Viewing Data in a MySQL Database

The MySQL Query Browser program (Version 1.1.1) can be initiated by selecting it from
among the programs accessible from the Windows Start menu or by double-clicking on the
“MySQLQueryBrowser.exe” file in the MySQL directory.  Users can also create a desktop icon
for this executable and open the program by double-clicking on this icon.  When this program is
opened, the user will be prompted for information needed to connect to the MySQL databases. 
Unless the user is using MySQL for other applications, all that needs to be entered is the
username and password.  These should be the same as the MySQL username and password
entered as scenario parameters in the TRIM.Risk scenarios (default is username = trim; password
= trim).4

On the right side of the Query Browser window is a list of the databases that are available
(under the “Schemata” tab).  The user can click on the triangle on the left side of a database
name to make the tables within the database visible.  Double-clicking on a table name will
automatically write a query in the box at the top of the window (i.e., the query area).  It will say
something like:

SELECT * FROM trainingdb.tbler_benchmarks t

This is a MySQL query that requests all rows of the table “tbler_benchmarks” be retrieved from
the database “trainingdb”.  Click on the “Execute” button and the table will open in the “Results”
tab of the Query Browser.  Scroll through the table to see the fields and data contained within it.

3.2.2 Editing a MySQL Database

The data in a MySQL database (viewed via a table query) can be edited in the MySQL
Query Browser (Version 1.1.1).  Query a table as described in 3.2.1.  After the table appears in
the “Results” tab, click on the “Edit” button below the table.  Now it is possible to double-click
within a data field and change the value.  This could be used to make small-scale modifications
to input databases (such as adding more up-to-date exposure-response values to the human
health toxicity or ecological toxicity databases).  Type in the edited value, and the table cell will
appear purple.  Click the “Apply Changes” button to save the changes to the table.  After
applying the changes, the modified cell will appear green until the table is closed.  For
instructions on how to create a MySQL database or additional detailed instructions on how to
modify tables within a database, see the MySQL documentation.

3.2.3 Exporting Data from a MySQL Database

A MySQL results set can be exported using the MySQL Query Browser (Version 1.1.1)
into the following formats:
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• Comma-separated variable (CSV) text files;
• Hypertext Markup Language (HTML) files;
• Extensible Markup Language (XML) files; or
• Microsoft Excel® files.

To export data into one of these formats, either select “ExportResultset” from the “File” menu,
or right-click on the results set in the Results tab and select “ExportResultset.”  Then select the
desired output file type to export the data.

3.3 Basic Operations with DAVE

The two primary functions of DAVE are data export and data analysis.  With the data
analysis functions, DAVE can create tables and plots using the MIMS Analysis Engine and data
from MySQL databases generated by the various TRIM modules.  The relationship between
DAVE and the MIMS Analysis Engine is described in Appendix A.  With the export function,
DAVE can export databases into delimited text files for analysis and display in other programs. 
This section provides brief instructions for using DAVE.  See the DAVE User’s Guide, which is
available on the TRIM.Risk page, accessible via EPA FERA website
(http://www.epa.gov/ttn/fera) and downloadable with the TRIM installation package, for detailed
instructions.

DAVE may be accessed from within MIMS or used as a stand-alone program.  Within a
TRIM.Risk scenario, the “DAVE Database Selector” window (1) appears after DAVE has been
initiated, after all other module instances within the chosen scenario have run to completion.  To
run DAVE as a stand-alone program, double-click on the batch file “rundave.bat” in the TRIM
folder.

In the “DAVE Database Selector” window, the user selects the type of database from the
“Database Type” pull-down menu (or selects “All TRIM Databases” as shown here), then
chooses a particular database in the “Database Name” column.  The list of databases in this
window is created automatically by DAVE.  By default, DAVE will look in the “data”
subdirectory of the MySQL directory for any TRIM databases.  In addition, it will automatically
identify and include in this list any TRIM databases saved in other directories on the user’s
computer, provided these databases were created on this computer.  If users wish to access
databases created on other computers, these databases must be copied to the “data” subdirectory
of the MySQL directory.
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If a human health risk metrics database type is chosen, the user must also select a metric
from the “Available Metrics” pull-down menu at the bottom of the window.  After a database
type, database, and available metric (if applicable) have been chosen, the user can analyze or
export the data.  Note that each database type results in a unique DAVE configuration; thus, the
screen shots provided here are not identical to what each user will see, but are only examples. 

3.3.1 Data Export

The purpose of the export function is to make data from a TRIM database available
outside of MySQL in an accessible format.  A database is exported by simply clicking on the
“Export” button from the “DAVE Database Selector” window after selecting a database. 
Another window will open in which the user chooses the value delimiter, location of output files,
and if available, export options (export options availability will depend on the type of database
being exported). 

The “Export” button from the “DAVE Database Selector” window currently supports the
export of human health risk, ecological risk, and human health risk metrics databases.  Note that
exports of human health risk metrics databases are performed one metric at a time, unlike
exports of human health risk and ecological risk databases which are performed for an entire
databases all at once.  To export a metric from a human health risk metrics database, select a
TRIM human health risk metrics database in the “DAVE Database Selector” window, then select
the desired metric from the “Available Metrics” pull-down menu and click “Export.” 

Additionally, data from TRIM databases can also be analyzed using the DAVE analysis
functions and exported from the “Analysis Engine Table Application” window (by selecting
“Export” from the “File” menu), as described below.

(1) DAVE Database Selector window



5 Note that the currently available version of DAVE does not support the analysis of risk metrics
represented by a distribution (i.e.,  PRD, PRD_LT, PHD, PHD_L, PHD_LT, PHD_7_L, PHD_7_LT).  The multi-
dimensional nature of these metrics is not able to be properly represented by the current analysis and presentation
capabilities of DAVE.  These metrics can, however, be exported as described in Section 3.3.1.
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3.3.2 Data Analysis

To create graphs and tables within DAVE, click on the “Analyze” button in the “DAVE
Database Selector” window after selecting a database to progress to the “DAVE Analysis”
window (2).  Data analysis capabilities within DAVE include creation of the following tables
and plots:

Tables

• Basic;
• Percentile; and
• Histogram.

Plots

• Bar;
• Box;
• Scatter;
• Rank order;
• Discrete category;
• Histogram;
• Multi-histogram;
• Time-series;
• Tornado;
• CDF; and
• Percentile plots.

See the DAVE User’s Guide for a description of each of these tables and plot types.5

Depending on the needs of the specific application, the user selects the dependent and
independent variables to be displayed and also specifies the type of plot or table to be generated
by selecting one from the “Available Plots” or “Available Tables” menu at the bottom of the
window.  If data for multiple independent variables are available in the database, the user
decides which independent variables are included in the table or plot.  The user also chooses a
statistical function (if any) to be performed on the independent variables by clicking on the
“Choose” button and then selecting a function from the drop-down menu available in that
window. 
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(2) DAVE Analysis and Choose button windows

After choosing a table or plot type and, optionally, specifying an output directory for the
graphic display file, click on “Create” to progress to the Customize window (3).  Here the
various text labels for the graphic can be edited and the configuration of the graphic specified in
terms of the format, delimiter used, and number of significant figures.  Click “OK” to progress to
the next window, which will be different depending on the type of table or plot being generated. 
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 When generating a Histogram or Percentile table, the next window will be Customize
Type window (4).  This window is specific to Histogram and Percentile tables and lists options
related to data interpretation and display.  These options include:

• Form of the data (for a Percentile Table, data may be represented as quartiles,
quintiles, deciles; for a Histogram Table, data may be represented as frequencies,
percentages, or probabilities);

• Percentile or binning specifications (i.e., upper and lower bounds values,
number of bins); and

• If applicable, number formats (i.e., scientific notation, number of significant
digits).

(3) Customize window
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When generating a Basic table or after clicking “OK” on the Customize Type window,
the “Analysis Engine Table Application” window (5) opens.  This window shows the table that
was generated based on the option selected and the data.  Data may be exported by selecting
“Export” from the “File” menu of this window (as mentioned in Section 3.3.1).

(4) Customize Type window

(5) Analysis Engine Table Application window
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If a plot is being generated, the Customize window (3) will be followed by the MIMS
Analysis Engine Plot Type window (6).  Click on the “Set” button in the “Data sets” box to
choose the data sets to be displayed.  To change the border, margin settings, legend, axes, or text
labels of the plot, click on the “Edit” button next to that option.  Currently, only PDF file types
can be generated for graphs.  Specify the location of the output file, change the file extension to
“.pdf” and click “Save” to save the file; click “View File” to see a display of the plot in Adobe
Acrobat Reader®.

(6) Analysis Engine Plot Type window
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Appendix A
Relationship Between DAVE and

the MIMS Analysis Engine

MIMS currently consists of three primary components:

• The Framework, which is used to connect and run related models in the proper
sequence (according to their data dependencies);

• The Analysis Engine, a tool for creating plots and tables; and

• The Spatial Allocator, a tool for creating surrogates that are used as inputs to
emissions models and performing other types of spatial allocation (this
component is not currently used in TRIM).

TRIM uses the MIMS Framework to run the TRIM modules and their associated processors, to
organize the TRIM modules into scenarios and projects, and to provide a user interface for the
TRIM modeling system.
 

DAVE uses the Analysis Engine to create plots and tables of data created and stored in
MySQL relational databases by the TRIM modules.  The relationship between DAVE and the
Analysis Engine is shown in Exhibit A-1.  To create tables, DAVE requests data from the TRIM
databases, creates internal tables based on the user’s specifications, and then uses the Table
Application to convert these internal tables into viewable tables.   To create plots, DAVE
requests data from the TRIM databases and then passes these data to the Analysis Engine plot
generator, which generates plots based on the user specifications.
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Exhibit A-1.  Relationship between DAVE and the MIMS Analysis Engine


